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With the rising cost of energyand growing environmental concerns, the demand for
sustainable building facilities with minimal environmental impact is increadihg. most
effective decisions regarding sustainability in a building facility are made in the early design
and preconstructiostageslin this context, Building Information Modeling (BIM) can aid in
performing complex building performance analysto ensure an optimized sustainable
building design. In thisexploratoryresearch, three building performance analysis software
namelyfEc ot ect E, Gr een Bui |VitiahEnvirdmeniE i arEe ( é5B&SI) u
to gage their suitability for BIMbased sustainability analysirst presented in this paper are

the main concepts of sustainability and BIM. Then an evaluation of the tibeme a
mentioned software is performed with their pros and cons. An analytical vixigltl scoring
system is used for this purpose. At the end, a conceptual framework is presented to illustrate
how construction companies can use BIM for sustainability aisand evaluate LEED
(Leadership in Energy and Environmental Design) rating of a building facility.
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Introduction

Buildings consme close to 40% of all energy used in the United States and account for 40% of glgbal CO
emissions(Schueter and Thessling, 2008he rising cost of energy and growing environmental concerns have
pushed the demanfibr sustainable building facilities witiminimal environmental impacthrough the use of
environmental sensitive design and construction practices (Autodesk, @0§&hizations such as the U.S. General
Services Administration (GSA) are increasingly requiring that architects, planners, amaiatorss meet these

energy codes in the delivery of federally owned building facilities. States such as Florida are following suit,
requiring all State owned buildings to meet standardized energy requirdettidesk 2008) Thi s type of
legislaton 6 i s increasingly forcing architects, pl anner s,
buildings they design and constr8chueter & Thessling, 20Q8)

—

The most effective decisionslated with sustainable designabuilding faciliy are made in the early design and
preconstructiorstages Traditional CAD planning environments, however, do not support the possibilgycbf

early decisions. Energy and performance analysisypieally performed, if at all, after the architecturasign and

construction documents have been produced. This lack of integration into the design process leads to an inefficient
process of retroactively modifying the design to achieve a set of performance criteria (Sahdétkessling,

2008). In order ta@ssess building performance in teelydesign angreconstruction phases realistically, access to

a comprehensive set of knowl edge regarding a buildin
required. BecauseBuilding Information Modeling (BIM) allows for multidisciplinary information to be
superimposed within one model, it creates an opportunity for sustainability measures and performance analysis to be
performel throughout the design procdgaitodesk, Inc., 2008; Schuetand Thessling2008).

Building Information Modeling (BIM) represents the process of development and use of a computer generated
model to simulate the planning, design, construction and operation of a building facility. The resulting model, a
Building Information Modg is a data rich, objeatriented, intelligent and parametric digital representation of the
building facility, from which views and data appropri



generate information that can be used to makisides and improve the process of delivering the facizhar et

al., 2007). BIM uses parametric object modeling technology to create relationships between objects within a virtual
building model. These relationships include physical and functionabdeaistics as well as project life cycle
information. A recent research study haglicated thataverage BIM Rturn onlnvestment(ROI) ranges from
634%1633%, which clearly depicts its lucrative economic benithar et al., 2008)

Since 2007 the GSAas required BIM use oall major projects and, although not required at this time, they are
encouraging fAaccur at e e n e rAytpdesk 2009) Thase regulations, whidh are aftens i gn p
implemented to reduce life cycle costs, can ehgwtentially significant financial implications on design,
construction, and operating cogfaitodesk, 2005)

BIM can reduce the costs associated with traditional en@mgustainabilityanalysis) while also realizing the

benefits associated withemr gy anal ysi s, by fAmaking the information r
certification routinely avail abl e si rpfjutodesk, 285BM bypr odu
provides the opportunity to realize numerous benefitsutiirout the project conception, design, construction and

post occupancy phases of a building facilitynking the building model to energy analysis tools allows for

evaluation of energy use during the early design phases. This is not possible usirgnata2iidi tools, which

require that a separate energy analysis be performed at the end of the design process, thus reducing the opportunities
for the early modifications that .could improve the bui

Research Objectives and Scope

Themain objectiveof this research is to explore the suitability of BIM for sustainability analykis.subobjectives

include the evaluation dthree building performance analysis softwaypes. These includEc ot ect E, Gr ee
Buil di ng St u dvirtwaEEnrcBBedE) . Imaudition to these sulibjectives is thelevelopment o

conceptual frameworklustratinghow construction companies can use BIM for sustainability anapsisvaluate

LEED® (Leadersip in energy and Environmental Desigajing of a building facilityThe research scope is limited

to commercial and healthcare building projects.

Methodology

The data for this researth collected via literatureeview of software manuals and sestructured interviews with
industry professional$iolder Construction Company (HC@Atlanta is a major contributor in this research. HCC is
a medium sizgeneral contracting company with current annual revenues close to $1 billionstd@tarket leader

in the Southeasegardinghe use of BIM technology and won the AGC National BIM award in 2007.

BIM -basedSustainability Analysis

As with traditional physical models and drawings, evaluating building performance based on the graphic
representations ofonventional CAD or objee€AD solutions requires a great deal of human intervention and
interpretation, which renders the analysis too costly and/ordonsuming (Autodesk, 2005 survey conducted

by the Center for Integrated Facility EngineerifGIFE) at Stanford Universitgited that economic reasorese
amongthe primarycausedor not implementing sustainable design and construgfoneduredy the majority of

survey resporehts (CIFE, 2004)

A Building Information Model represents the buildiag an integrated database of coordinated information. Beyond
graphically depicting the design, much of the data needed for supporting sustainable design is captured naturally as
design & the project proceeds. In addition, the integration of Buildingrinédion Model with Performance
Analysis tools greatly simplifies the often cumbersome and difficult analisis.approach gives architects easy
access to tools that provide immediate feedback on design alternatives early on in the design process.

Krygiel and Nies (2008) indicated that BIM can aid in the following aspects of sustainable design.



Building orientation (to select the best building orientathat resultsn minimum energy costs)

Building massing (to analyze building form and optimize th&ding envelope)

Daylighting analysis

Water harvesting (to reduce water needs in a building)

Energy modeling (to reduce energy needs and analyze renewable energy options such as solar energy)
Sustainable materials (to reduce material needs and to uskedeayaterials)

For projects pursuing LEEDcertification, many LEEB credits require that drawings be submitted to support the
qualification for credit. Although most of these drawings can be prepared using conventional CAD software, BIM
software producethese drawings more efficiently as part of the building information model and have the added
advantage of parametric change technology, which coordinates changes and maintains consistency at all times.
Thus the user does not have tmanually update drawigs or links. Similarly, such models carry a wealth of
information for many other aspects of sustainable design and/or YE&ifification. For instance, schedules of
building components can be obtained directly from the model to determine percentagésriall neuse, recycling,

or salvage. In addition, advanced visualization technigues can convince skeptical clients that green design performs
well and looks goodAccording to Autodesk (2005), up to 20 points for LEErtification can be facilitated umsj

BIM.

Building Performance Analysis Software A Case Study

The rationale of this evaluation is to gage the suitability of leading building performance analysis software for BIM
based sustainability analysiEhe tree softwardypesselected for thipur pose wer e Ecotect E,
Studi oE (Vet@abBnvirenmehk . Ho | d e rion Canpanyt (HQCE dcquired tbesoftware and the
analysis was performed by their BIM division. The project selected for this purpos& wesr v Uni ver si t
Psydology Building (Figure 1)which received a LEED Silver certification BIM was used in the early design

phase to determine best building orientation, evaluate various skin type design options such as masonry, curtain wall
and window styles, perform energynd daylighting analysjsaind create a LEEDdaylighting credit qualification

report.

Option 1 - Curtain wall Option 2 - Masonry

3D Sun Study

ER
R

West Elevation West Elevation

Figurel: Use of BIM for Options Analysis and Sun Studies in the Emory Psychology Building
(Courtesy of: Holder Construction Company, Atlanta, GA)



Figure 2 depictsthe process of BIM and Building Performanealysis Software integration by outlining various
data transfer steps. The boxes on the right hand side indicate software features evaluated in this analysis.

BIM Applications :> Environmer|1tal Analysis |:> Building Simulation Tools |::> Primary Program Features
Data File Types

Energy / Thermal - Resource Management
Thermal Analysis

*Uses Room Tags Heating / Cooling Loads

Ventilation and Airflow
Model Preparation: 3 : -
0- See Help-> Model Guidance Lighting / Shading - Solar Analysis
Right-to-Light Analysis
1- Settings
-> Area and Volume Computations
- Check “Areas and Volumes”

Daylighting Assessment
Shading Design

Lighting Design

2- Settings . 5
> Project Information Typical Inputs: Other Analysis - Acoustic
-> Energy Analysis - Data > Edit Define- Building Type
> Set Inputs Construction Materials
- Building Type System Types (Heating / Cooling)
- Postal Code Room Type (Zone Management)
- Project Phase Project Location (Weather Files) Energy / Thermal - Energy Usage

3- Create Rooms / Volumes Carbon Emissions

- Check Room Upper Limits & Offsets Export File Ventilation and Airflow
->Select room-> Element Properties Import File
B g bXM L Lighting / Shading - Daylighting Assessment
4- Double Check for “void” spaces LEED Daylight Credit 8.1

- Create Rooms to fill these “voids”
Value / Cost Analysis- Lifecycle Assessment
5- File=> Export gbXML file

J - IFC

*Uses Zone Tool

Lifecycle Cost

Energy / Thermal - Energy Usage
Carbon Emissions
Thermal Analysis

Heating / Cooling Loads
Ventilation and Airflow
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Figure2: Integration of BIM and Building Perfatance Analysis Software
(Courtesy of: Holder Construction Company, Atlanta, GA)

The following paragraphs briefly discuss each softveardther respectivdi pr os 6 and Aconso.
EcotectE

Ecotect E, owned by Autodesk, Il nc. , is Aa complete buil
full range of simulation and analysis functions required to truly understand how a building design will operate and

p er f QAutodésk, 2008).The primary program analysis capabilities include energy analysis, thermal analysis,

and lighting/shading analyses. The energy and thermal analysis features take into account factors such as resource
management, heating and cooling loads, amdiladion and airflow. The lighting/shading analysis tools allow for

solar analysis, righto-light analysis, daylighting assessment, shading design, and lighting design. Ecatset

allows for other building facility assasgnts such as acoustic analybigure3 depicts the performance analysis of

Emory Psychology building using EcotectE with its fdpro

Green Building StudioE (GBS)

Green Bui |l di ngnedhy AulodeskAnc., imd wsimsedoenergy analysis service that allows users to
evaluate the environment al i mpact of individual buil d
primary analysis capabilities include energy and thermalysisallighting and shading analysis, and value/cost
analyses. The energy/thermal analyses evaluate energy usage, carbon emissions, and ventilation and airflow. The
lighting and shading analyses assess daylighting and include the®LIBE&ight Credit 8.1 éature. The value and



cost functions determine lifecycle assessments and lifecycle costs. Rigli@vs the performance analysis of
Emory Psychology building using GBSE with its fiproso a

AUTODESK ECOTECT
PROS

-Model viewing capabilities
-Analysisresults are stored in a
single file

-Resultant graphics are easily
understood

-Quick and precise resultviewing
-Variety of displayed mediums
-Zone management system
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CONS

-User interface is difficult to

understand

-Analysis steps, or procedures, are

unclear

-Thereisno gbXML error check

-Analysisrun times are very long
. — LR L AL -Some analyses cause program

Emory PsychologylodelView inVisualization Tab instability

-Success of analyses is inconsistent
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Figure3: Ecot ect E f P(€Coorkesy: HE@, Atinta,GA)N s 0

Virtual EnvironmentE

I ntegrated Environment alE sStwdraid d soite sf dntegrated buildad perormanice o n me n
analysis tools. These tools provide analyses for issues including solar, lighting, energy, costs, egreasy and m

others. The energy/thermal functions include energy usage, carbon emissions, thermal analysis, heating/cooling load
evaluation, and ventilation / airflow evaluation. The lighting / shading functions include solar analysis, daylighting
assessment, andEED® Daylight Credit 8.1 capabilities. The value/cost analysis functions include lifecycle
assessment and lifecycle coBigure5 illustratesthe performance analysis of Emory Psychology building using

VEE with its fAproso and fAcons
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PROS

-Automated online process with
step-by-step procedure

-Very little preparation work
required

-Quick transition from Revit model
to gbXML analysis (Revit plug-in)
-Automated ghXML error check
-Large output to time spent ratio
-Simple user interface

-Provides LEED daylighting analysis

CONS

-Trouble with larger files

-Unable to specify analysis type(s)
-One predetermined broad
analysis

-Limited analysis types

-Difficulty linking ghXML data to
online database
-Requiresinternet connection
-Requireslogin/password to link
file and access analysis results

Figure4: Green Building Studié i Pr o s 0 ¢Couttesyi I9aCnAtlanta, GA)
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PROS

-Direct Revitplug-in

-User interface mimics Revit
-Major analysesin a single click
-Relatively short analysis run times
-Result structure and organization
-Large number of available
analyses

-Lifecycle assessment and cost
-LEED Daylighting Credit 8.1 test

CONS

-Results saved separately from
main project file

-Inconsistent analysis run success
between different
toolkits/methods

-Limited model viewing capabilities
-Model preperation requires
manual gbXML error checking with
limited error report

Figure5: IES Virtual Environmerf A Pr os 0 (Coultesyi @QCnAtlanta, GA)






